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Introduction to IQmfp 

IQmfp is a simple electronic filing system for select models of HP LaserJet MFPs, HP ScanJet workgroup scanners 
and HP Digital Senders. Easy to use and install, the IQmfp document management solution is integrated with the 
MFP front panel and allows documents to be scanned into a SQL database for indexing and OCR processing for 
full-text search. There are connectors for storage and retrieval of Microsoft Office documents and WordPerfect 
files, as well as Microsoft Outlook email and attachments. The Windows Explorer Connector allows indexing and 
retrieval of a wide range of electronic files, and IQmfp can be configured for easy integration with the HP Smart 
Document Scan Software (SDSS) included with ScanJet workgroup series scanners. 
 
Please contact us below for technical support and/or troubleshooting: 
 
IQmfp Support 
(407) 215-1291 
iqmfpsupport@informasoftware.com 
http://www.informasoftware.com/support  
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Scanning Documents to IQmfp 

To scan documents into IQmfp, load the Automatic Document Feeder or ADF on top of the HP MFP device with 
up to 50 sheets to be scanned.  A group of documents scanned at the same time is called a “batch”. 

 

Note: The ADF capacity limit does not reflect the limit of your batch size.  See the section “Scanning the 
Documents” on the following page for more information on adding additional images to a batch. 

 
Press the IQmfp icon on the HP MFP front panel as illustrated in Figure 1.1 to begin the scan process. 

 

 
                                                        Figure 1.1:  HP MFP front panel 

 

User Selection 
The IQmfp User Selection screen in Figure 1.2 on the following page allows for the selection of a name to route 
scanned documents from a scrollable user list screen.    

 
Select a user from the list.  If a user is not in the selection list, please contact your network administrator.  IQmfp 
will route any scanned batches to this user for access in the Indexing Queue when the user logs in to IQdesktop.  
See “Indexing Documents,” p. 11, for more information. 
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                                                                              Figure 1.2:  IQmfp User Selection 

 
Press “OK” to continue to the Scanner Status:  Ready to Scan screen.  

Scanning the Documents 
Follow the instructions on the screen in Figure 1.3. 

 

 
                                                                Figure 1.3:  Ready to Scan 

 
Select the IQmfp “Options” button to verify the MFP is configured correctly for the scanning process as 
displayed in Figure 1.4. 

 

 
                                                               Figure 1.4:  IQmfp Scan Options 
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Select any special settings needed for this batch of documents and click the “OK” button to return to the Ready 
to Scan screen. 

 

Note:  Some HP MFP devices do not scan duplex on one pass.  For 2-sided pages, the device will scan one side, 
then pull the image back through to scan the other side.  Scanning 2-sided pages on the device will double the 
time of scanning per page. 

 
In Figure 1.5, press “Scan” to begin scanning the documents.   

 

 
                                                                 Figure 1.5:  Ready to Scan 

 
The Scanner Status changes to Scanning as the documents are scanned as shown in Figure 1.6. 

 

 
                                                                                           Figure 1.6:  Scanning  

 
If your document or batch has more than 50 pages, wait for the first 50 pages to finish scanning and for the MFP 
to return to Scanner Status:  Waiting for Documents as noted in Figure 1.7 on the following page. 
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                                                                              Figure 1.7:  Waiting for Documents 

 
Load the additional pages into the ADF and then press the “Scan” button again to append the additional pages 
to the document. 

Completing the Batch 
If you have more than one batch of documents to scan, wait for the first batch to finish scanning, load the ADF 
with the second batch, and press “Submit”.  This sends the first batch to IQmfp and returns focus to this screen 
in Figure 1.8 to scan again without logging the user out. 

 

 
                                                            Figure 1.8:  ImageQuest mfp—Waiting for Documents 

 
The Status Message in Figure 1.9 shows that ImageQuest MFP is uploading the current batch to the IQ Server.  
Press “OK” and press “Scan” to scan more documents, or press “Done” when finished to log out and return to 
the MFP front panel. 

 

 
                                                     Figure 1.9:  ImageQuest mfp Status Message 
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IQdesktop 

IQdesktop is the primary ImageQuest component – installed as a Windows application - used to store and 
retrieve documents.  IQdesktop provides all the features necessary for document indexing and retrieval and also 
includes advanced features such as document routing, document revisioning, complete document history, 
adding and viewing notes, exporting to folder, etc.   
 
In addition to basic searching, full-text search is an included component of IQdesktop.  Most common Windows 
file types such as .txt, .doc, .pdf, and .xls documents that are indexed will be available for Full-Text Search.   
 

Launching IQdesktop 
Once the user has scanned documents to IQmfp, the user is ready to launch IQdesktop as shown in Figure 2.1.  
Go to Start > All Programs > Informa Software > ImageQuest and click IQdesktop. 

 

 
                                                                                                                       Figure 2.1:  Launch IQdesktop 

 
Figure 2.2 on the following page shows the default layout to IQdesktop’s major features:  “Toolbar,” “Search,” 
“Indexing” and “Lists”.   
 

Note:  If an IQ user has Single Sign-On enabled and is logged into the PC, they will be automatically logged into 
IQdesktop.  Otherwise, they will need to provide a username and password in order to access the cabinet.   
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                                                        Figure 2.2:  IQdesktop 

 

Indexing Documents 

The Indexing Queue found in IQdesktop is the end-user’s tool to classify and index documents within a scanned 
batch and export the images and their index values to the Cabinet; it also allows users to reassign document 
batches to other users or roles.   
 
To view the Document Indexing screen, locate the “Indexing” section on the Tasks panel and click “Indexing 
Queue” as highlighted in Figure 2.3.   

 
                                                                                Figure 2.3:  Indexing Queue 
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Note:  The “Add Document” permission is required to allow users to add a document for indexing.  See the 
IQmfp Administrator’s Guide 10.0:  Manage Users and Roles to allow or deny permissions. 

 
The Indexing Queue shows all available document batches for the user logged into IQdesktop as illustrated in 
Figure 2.4.  Document batches may be indexed, deleted or reassigned to another user or role. 
 

 
                                                           Figure 2.4:  Document Batches 

 
The Index feature allows users to save documents in IQmfp and establish their search criteria with their 
corresponding attributes to effectively and efficiently locate those documents.  To index a batch, highlight the 
batch and select Index (Ctrl+I) from the “Batch” menu or right-click the batch and select Index.  See “Indexing 
and Committing Batches” beginning on pg. 14 for more information. 
 
To reassign a batch to another user or role, highlight the batch and select Reassign (Ctrl+Alt+R) from the “Batch” 
menu, or right-click the batch and select Reassign; to reassign all batches, press Ctrl+A to select all as 
highlighted in Figure 2.5 on the following page and then select Reassign.  The Ctrl key can also be used to select 
multiple batches. 
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                                                                               Figure 2.5:  Reassign Batch or Multiple Batches 

 
In the “Batch Reassignment” window in Figure 2.6, use the drop-down menu to select the user or role to 
reassign the selected batch to as demonstrated and click “OK”.   
 

 

  

 

 
                             Figure 2.6:  Batch Reassignment 

 
By reassigning the batch to a role, every member in that role has access to the document batch in their Indexing 
Queue.  By reassigning to a user, only that specific user has access to the document batch.  Once a user opens a 
batch, it will be locked for exclusive use for thirty minutes.  If the indexing process takes longer than this, the 
lock will be expired and the batch will once again become available for indexing to other users in that role.  Once 
a batch is indexed by a user, it is no longer available for indexing by any other user.   
 
To delete a batch from the Indexing Queue, right-click on the highlighted batch and select Delete or highlight 
the applicable batch(es) and select Delete (Ctrl+Alt+D) from the Batch menu as demonstrated in Figure 2.7.  The 
user will be prompted with a confirmation window as seen on the following page in Figure 2.7.1. 
 

 
                                                                           Figure 2.7:  Deleting Document Batches 
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                                                                            Figure 2.7.1:  Delete Confirmation 

 

Note:  “Delete Batch” permission is required to delete a batch from the Indexing Queue. 

Indexing and Committing Batches 
Document batches are “time-stamped” with the specific time they were scanned at the HP MFP device.  To 
choose one of the batches to index, highlight the batch as demonstrated in Figure 2.8, double-click it or right-
click to open the menu and select Index (Ctrl+I).  This will open the main Indexer screen. 
 

Note:  Multiple batch selection is NOT available for the Index (Ctrl+I) option; only one batch can be indexed at 
a time. 

 

  
                                                      Figure 2.8:  Indexing a Batch 

 
The Indexer screen allows a user to view the individual pages of the batch and designate pages as the beginning 
of documents for indexing.  See Figure 2.9 on the following page to locate the “Pages,” “On Screen Help” and 
the “Document Window” to “Zoom”, “Rotate” or “Smooth” the document image.   
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                                                                                                                   Figure 2.9:  Indexing Documents 

 
The “Pages” pane allows the user to click each page number to view each scanned page; the “On Screen Help” 
in the lower, left corner in Figure 2.10 provides simple directions, for example, to designate each page or to 
delete a page, and the directions will change as progress is made on indexing the documents. 

 

 
                    Figure 2.10:  On Screen Help 

 
The “Smooth Image” button is on by default for better image quality, but may be disabled in order to increase 
performance. 

 
To make the image larger or smaller in the document window, click and select a size from the “Zoom” drop 
down menu as displayed below in Figure 2.11. 

 

 
                  Figure 2.11:  Zoom 
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Click the Rotate 90 button to rotate the image as displayed in Figure 2.12.  This rotation will persist when the 
page is saved in IQmfp. 

 

 
                                     Figure 2.12:  Rotate 90 

 

To close the window and return to the Indexing Queue, click  or to close the Indexer altogether, click 
 to the far right of its window as targeted in the illustration below in Figure 2.13.  Any changes made to the 

current batch will be lost once the Indexer is closed. 

 

 
                                                                                        Figure 2.13:  Close Window Options 
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To begin indexing the documents in the batch, designate the first page of the first document by using the 

<SPACEBAR> as directed in the “On Screen Help;” once the <SPACEBAR> is pressed, the  icon will appear to 
the left of the page number indicating that the page is the beginning of the document. 

 
The “Document Type” drop-down menu will become active as highlighted in Figure 2.14; the user may also 
designate the first page by right-clicking on the document page and selecting Beginning of Document.   

 

 
                                          Figure 2.14:  Indexing a Document 

 
In the drop-down menu, “Document Type,” select the document type to designate the first page of the 
document.  For example, in Figure 2.15 on the following page, the first page of the highlighted document is an 
invoice which means that this page is designated as the first page of the document type, “Invoice”.   
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                                                                                              Figure 2.15:  Assign page to a Document Type 

 

Note:  If a “Document Type” is not in the list, see pg. 61, for more information on “Managing Document 
Types” or contact your system Administrator. 

 
When a document type is selected, the indexing fields for that document type become accessible as shown in 
Figure 2.16 on the following page.  The “On Screen Help” window below prompts the user to <TAB> through the 
index fields that appear for the document type; these fields are called “Attributes” and become the index values 
that are used when searching for a document within IQmfp.   
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            Figure 2.16:  Indexing Fields 

 
 
 

 
If attribute data appears on multiple pages, the attribute data will remain when selecting different pages of a 
document as highlighted below in Figure 2.17 for Page 2.  This is useful if the index values are located on a page 
other than the beginning page of the document, for example, an invoice total.  

 

 
                                                                     Figure 2.17:  Common Indexing Fields 
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Once the last index field is filled in for a document type, <TAB> to return to the “Pages” pane, or click on the 
next page to index the additional documents with each corresponding document type and completed index 
values as shown in Figure 2.18.  For example, Page 3 is a new document type, “Billing,” with Page 3 as the 
beginning page and Pages 4 and 5 as the attached pages; the attributes and indexing fields, “Client ID,” 
“Customer Name” and “InvoiceAmount” can be filled in for indexing prior to committing this batch.   
 

 
                                        Figure 2.18:  Indexing 

 
If there are no more documents in the batch to index as shown in Figure 2.18 above, the batch is ready to be 
committed;  the “On Screen Help” window as highlighted in Figure 2.19 guides the user to commit the batch 
after indexing all pages—“use <CTRL+S> or select “Commit” with the mouse to finish indexing the batch.” 
 

 
                                                        Figure 2.19:  Committing a Batch  

 
The “Confirmation” window in Figure 2.20 on the following page appears; click “Yes”.  The batch will be 
committed and after a few seconds, click “OK” in the “Completed” window.  If you click “No,” you will return to 
the active batch. 
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                                          Figure 2.20:  Confirmation 

 
The “Confirmation” dialog box will report the number of documents to be stored in the Cabinet.  Pages without 
icons next to them are not counted as part of the number of documents as illustrated in Figure 2.21.  For 
example, Page 2 will be attached to Page 1 to the Document Type, “Invoice” highlighted in yellow and Pages 4 
and 5 will be attached to Page 3 to the Document Type, “Billing” highlighted in blue.  This results in two 
documents being sent into IQmfp, one two-page Invoice document and one three-page Billing document. 
 

 
                                                                  Figure 2.21:  Attached Image 

    
 
 
 

Note:  To cancel out of “Indexing,” click “Cancel” at the bottom, left of the index fields. 
Note:  If required index values were not entered, a “Document Error” screen will show which page and which 
document has the missing value.  Click the “Abort” button to stop the batch commit and make any necessary 
corrections. 

 
 
 
 
 



  IQmfp User’s Guide 10.0 

22 
 

Once a batch is committed, the user will return to the Indexing Queue to show remaining batches to index as 
displayed in Figure 2.22. 

 

 
                                                       Figure 2.22:  Document Batches 

Page Features in the Indexing Queue 
The available options on the right-click menu in Figures 2.23 are Beginning of Document, Exclude this Page, 
Move Page Up, Move Page Down and Clear Selection.  You can exclude a page from a batch by highlighting and 
right-clicking it to select Exclude this page.  When the document batch is committed, the images marked to be 
excluded will not be included with the documents.  For example, in Figure 2.24 on the following page, Page 5 
has been excluded.  When this batch is committed, we will have two documents in IQmfp:  one, two-page 
“Invoice” document consisting of Pages 1 and 2 and one, two-page “Appointments” document consisting of 
Pages 3 and 4. 
 

  
                                                                                                Figure 2.23:  Exclude This Page 
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                            Figure 2.24:  Excluding a Page 

 
Changing the order of the pages in a batch is also possible by right-clicking on a page and selecting Move Page 
Up (Ctrl+U) or Move Page Down (Ctrl+D) as modeled in Figure 2.25.  For example, Page 4 has been highlighted 
and moved up; as a result, the document type, “Invoice,” is now a three-page document consisting of Pages 1, 2 
and 4, and the Document Type, “Appointments,” now only consists of Page 3 as Page 5 has been excluded. 
 

 

 

 
    Figure 2.25:  Move Page Up or Down 

 
Clear Selection is used to deselect a page that has already been designated as a new document or that has 
already been excluded.   

Training Mode 
The feature Training Mode highlighted in Figure 2.26 on the following page allows focus on areas of the image 
to increase visibility and ease of indexing.  You can use this mode to configure the document template for 
review.  To enable this mode, click Training Mode below the “Indexing Queue” tab. 
 
Next, select a Document Type and use the Zoom function to change the view of the document.  Under each 
corresponding field, there will be a Save Image Position button as shown in Figure 2.26 on the following page. 
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               Figure 2.26:  Training Mode 

 
After you zoom in on the desired section of the document, click Save Image Position to save the current position 
or magnification. 
 
Once the image positions have been saved, click the Training Mode button again to return to indexing.  From 
now on, the trained document type will automatically zoom to the appropriate areas as you tab through the 
attributes.  Trained document types are user and machine specific, meaning that if another user logs into the 
same client PC, the document types will need to be retrained. 
 
To remove training from a specific document type, enable Training Mode, set the zoom level to “Entire Page” 
and click Save Image Position for each attribute. 
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Searching for Stored Documents  

The Search task allows for a wide variety of search options:  “Custom Search,” “Keyword Search” and “Saved 
Queries”; these allow the user to perform a search based on any attribute value, one or more specific Document 
Types, and/or keywords within indexed documents. 

Custom Search Tab 

To initiate a search for documents, click the Search (Ctrl+F) icon  in the toolbar, use the “Tools” menu to 
select the Search (Ctrl+F) function as highlighted in Figure 3.1 or click the “Advanced” link. 

 

 
                               Figure 3.1:  Search 

 
In Figure 3.2 on the following page, a search is in effect for a two page Invoice with an InvoiceDate of 7/2/2008.  
By selecting a single Document Type, the list of all available attributes on the right is changed to reflect only 
those attributes associated with that Document Type.  Click “Search” once the desired index fields are 
completed.   
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                                                                                     Figure 3.2:  Custom Search 

 
The custom search results in Figure 3.3 returns two Invoices with an InvoiceDate of 7/2/2008.   
 

 
                                                               Figure 3.3:  Custom Search Results 

 
When a second Document Type is selected, only the attributes common between the two Document Types will 
be available for search.  Whenever a range of results is possible, the word ‘to’ will appear between the left and 
right attribute fields.  When searching within text fields, the ‘or’ statement means that either or both criteria 
entered (whichever is true for the Document Type selected) will be returned in the search results.   
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Note:  The wildcard value (*) may be used when exact information is not known, or when broader search 
results are desired.  For example, entering the asterisk at the end of the value like ‘smi*’ means that you are 
searching for any value that begins with the letters ‘smi’.  This search will return both ‘Smith’ and ‘Smithers’, 
etc.  Placing the wildcard at the beginning and searching for ‘*mith’ will return items that end in ‘mith’, like 
both ‘Smith’ and ‘Blacksmith’.  Placing a wildcard at both the beginning and the end and entering ‘*mit*’ will 
return items that have ‘mit’ anywhere, like Smithers, Mitchell, Permit, etc. 

Saved Queries Tab 
“Saved Queries” are predefined and configured to allow users to perform common and frequent searches with 
ease and efficiency.  These save time, yet are limited to the search criteria established in the query. 
 

The user may perform a search using the “Saved Queries” method in IQdesktop.  Click the search icon , 
select Search (Ctrl+F) in the Toolbar or click the “Advanced” link to open the “Search” window.  Then, click the 
“Saved Queries” tab as shown in Figure 3.4 to select a saved query from the drop down menu.  Fill in any 
required attributes and then click the “Search” button. 
 

 
                                                              Figure 3.4:  IQdesktop Search Window—Saved Queries 

 
Figure 3.5 on the following page gives an example of a saved query search based on the “Client ID” attribute and 
its search result.   
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   Figure 3.5:  Saved Queries Search and Results 

 

Note:  Saved queries must be configured in the IQadministrator  tool to be accessible from IQdesktop; see the 
IQmfp Administrator’s Guide 10.0 for more information on how to configure “Saved Queries”.   
Note:  Wildcard values (*) may NOT be used when inputting the user parameters of a saved query; if Full-Text 
searching is enabled, keywords may be entered in addition to saved query criteria to create a combined 
attribute based and keyword based search.  See the “Keyword Search” section for more information. 

 

Keyword Search 
Another way to search for stored documents is by entering the keywords in the “Keywords” field in the “Tasks” 
panel.  Most common file types such as .txt, .doc, .pdf, and .xls documents are available for Full-Text search; the 
search results will include all documents that contain the keyword criteria entered.   
 
See Table 1 on the following page for search string examples and descriptions of valid full-text search syntax. 
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Search String Example Description 

Invoice  Simple Match  

Invoice OR Fax  OR 

Software Hardware  Implied AND  

Software AND Hardware  AND  

Software NOT Hardware  Implied AND NOT  

Informa*  Wildcard  

(Software AND Hardware) AND NOT Informa  Parenthetical grouping  

"Informa Software"  Exact phrase match  

Table 1:  Search Strings and Descriptions 

 

Note:  Wildcard values (*) at the beginning (*forma) or in the middle (in*ma) of a word are not supported.   
Note:  Full-text search results include a preview field with summary text that matched the search criteria 
entered. 
Note:  When using symbols and other non-alpha characters in the Keyword field, it is necessary to enclose the 
search terms in quotation marks (i.e. “Joe’s Crab Shack”). 

 
To use “Keywords,” enter the phrase as the search criteria (and any custom or saved query criteria), for 
example, “Packing List,” and click “Search”.  See Figure 3.6 to view the search results displaying three 
documents relevant to the search criteria, “Packing List”. 
 

 
                                                                               Figure 3.6:  Keyword Search and Search Results 
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The blue highlight below each record shows a preview of the text in the document where the keyword appears.  
There is also a column called “Rank” as highlighted in Figure 3.7 that gives the ranking of a document based on 
relevance of the criteria entered; in this example, the top Packing List document ranks at 32, and the bottom 
ranks at 21.  The higher the ranking, the more relevant to the search criteria entered.  

 

 
                                                                 Figure 3.7:  Document Rank 

 

Note:  It is possible to perform more than one search and display the search results at the same time.  See pg. 
52, “New Search Tab,” for more information. 

Viewing a Document 
Once the search function locates the desired documents, the documents may be viewed.  To view a document, 
double-click it or right-click on it to open the menu and select View Image (Ctrl+I) as illustrated in Figure 3.8.  
You may also use the Document menu or the toolbar button. 

 

 
          Figure 3.8:  View Image 
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A document like the sample in Figure 3.9 and any attached pages are displayed in the user’s default image 
viewer; this figure shows a PDF file opened in Adobe Acrobat Reader. 

 

 
                                                                               Figure 3.9:  Viewing a Document 
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Configuring the View 

IQdesktop is highly configurable, allowing the user more screen “real estate” to display the information about 
the documents in a way that is most valuable to the user; the user also has leverage to emphasize any 
information displayed in each document.  For example, by selecting which data columns are more desirable in 
sorting, grouping, and criteria for filtering.   
 
IQdesktop is comprised of three main areas by default, the Tasks panel on the left, the search grid on top and 
the Notes/History panels on the bottom as seen in Figure 4.1.  This screen can be customized in a variety of 
ways by hiding and closing some or all of the panels or by moving the panels to different parts of the screen. 
 

  
                                       Figure 4.1:  IQdesktop Main Layout 

 
To increase screen “real estate”, locate the pushpin icons on the “Tasks”, History”, and “Notes” panels as 
highlighted in Figure 4.2 on the following page. Unpinning the panels causes them to slide out of the way.  To 
access the hidden panels, simply hover over the tabs.  Click the pushpin again to allow the panels to always be 
shown on the screen.  The panels may also be closed altogether by clicking on the X to the right of the pushpin. 
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                                 Figure 4.2:  Pushpins 

 
Another way to increase the screen “real estate” is by moving the mouse cursor between two panels until the 

 cursor shows up.  Once the cursor changes to the double arrow click and drag the cursor to expand the 
panel as shown below in Figure 4.3. 

 

 
                                                                     Figure 4.3:  Increasing Real Estate 
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The three panels (Tasks, Notes and History) can also be moved around the screen and customized.  To move one 
of the panels, first make sure that the panel is pinned.  Next, click and drag the panel tab name to one of the 
drop position indicators as shown in Figure 4.4.  Release the mouse button when the panel shadow preview 
appears in the location you want.  In the example below, the “Notes” panel has been moved next to the 
“History” panel so both are viewable at the same time. 
 
 
 
 
 
 
 
 
 
 

 

  
                                                                           Figure 4.4:  Rearranging the Panels  

 
To return to the default window layout at anytime, go to the “View” menu and select Default Window Layout as 
illustrated in Figure 4.5 on the following page. 

 
Panel positions are saved automatically per user/per machine.  If a user changes the view of the screen and logs 
out, once he/she logs back in, the screen view will return. 
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Figure 4.5:  Default Window Layout 

Column Customization 
Figure 5.1 shows a sample of the IQdesktop column headers.   The document grid columns may be customized 
to better meet your needs.  Columns can be moved, removed, added, widened or narrowed. 

 

 
                                                                Figure 5.1:  Column Headers 

 
To move a column header, left-click on the column, drag and release it in the header row where the column is 
desired.  For example, CreateDateTime in Figure 5.2 is being moved from its default location to the right, in 
between PageCount and DocumentType. 

 

 

    

 

 
                                                      Figure 5.2:  Column Customization 
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A user can remove a column by left-clicking on the column header to be removed and holding down the left-
button to drag the column out of its initial setting as modeled in Figure 5.3.  An X will appear in place of the 
normal mouse cursor.  For example, the column, “Appointment Date and Time,” is being removed from the 
header. 

 

 
                                                                         Figure 5.3:  Removing a Column 

 
Release the left button to remove the column.  The column name is deposited in the “Customization Window” 
which stores columns that are hidden from the user. 
 
To add a column back to the header, right-click on the header row and select Column Chooser from the menu as 
displayed in Figure 5.4.   

 

 
  Figure 5.4:  Column Chooser 

 

 

 

 
The “Customization” window will open.  As demonstrated in Figure 5.5 on the following page, drag the column 
name from the Customization window back to the header row by left-clicking on it, dragging it and releasing it.  
In the example on the following page, the column, “Appointment Date and Time,” is returned to the header. 
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                                                                                Figure 5.5:  Adding a Column  

 
Columns can also be narrowed or widened depending on how much column space you require for any column 
displayed as demonstrated in Figure 5.6.  To narrow or widen a column, position the mouse across the line 

dividing the two columns until you see   and left-click and drag, moving to the left to narrow or to the right 
to widen the column; the CreateDateTime column is being narrowed in the figure below. 

 

 
                                                                                 Figure 5.6:  Column Customization 
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Best Fit 
The Best Fit feature automatically sizes a column to fit the maximum length of data in the column at the time of 
sizing.  To expand a specific column like CreateDateTime to the best fit for viewing, double click between the 
column headings or right-click on the header row and select Best Fit as displayed in Figure 6.1.  To expand all the 
columns at once, select Best Fit (all columns) from the right-click header. 

                             

 

 

 

 

 

 

 

 

 

 
                                              Figure 6.1:  Best Fit—One Column 

Sorting 
Sorting can be performed on any displayed column in ascending or descending order.  There are two ways to 
define the sort option:  1) click on the header as targeted in Figure 6.2 to display the results in ascending or 
descending order; 2) right-click on the column header of the column to open the header menu and select “Sort 
Ascending” or “Sort Descending”.  The data in the grid will then be sorted accordingly once you click it.  To clear 
any sorting selection, right-click on the column header and select Clear Sorting. 
 

 
             Figure 6.2:  Sort 

 
 

Note:  Multiple columns may be sorted by holding the shift key down while clicking additional column 
headers, one at a time. 
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Grouping 
IQdesktop allows for the grouping of one or more columns which allows for a different view of the grid.  It also 
shows a row count associated with each attribute value.  There are two ways to group columns:  1) right-click on 
the column header intended for grouping; this will open the header menu as displayed in Figure 6.3.  Select 
Group By This Column which moves the column to the Group By Box above; or, 2) click and drag a column 
header to the Group By Box.  Repeat either grouping method as needed to group by multiple columns.  

 

  

 

 
                                            Figure 6.3:  Grouping 

 
To ungroup a column, right-click on the column in the Group By Box and select the Ungroup option, or click and 
drag the column back to the column header as demonstrated in Figure 6.4.   

 

 
                                                       Figure 6.4:  Ungroup 

 

 

Note:  To clear the contents of the Group By Box, right-click anywhere in the box and select Clear Grouping. 
Note:  The grid may be fully expanded or fully collapsed (Figure 6.4) by right-clicking anywhere in the Group 
By Box and selecting the appropriate menu item.   
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Filters 
Filters limit the returned search results and help customize a view to easily locate data.  One or more filters can 
be applied to columns currently displayed in the document grid.   

 
To apply a filter to a column, left-click on the drop-down menu arrow on the right-hand side of a column header.  
As shown in Figure 6.5, the drop-down menu will list all of the values currently in the column for convenient 
selection as a filter.  Once a value is selected, the drop-down menu will close and the display grid will show the 
rows of data that matched the selected value.   

 

  
                                                    Figure 6.5:  Applying a Filter 

 
The bottom of the grid now displays the applied filter, ‘7/1/2008’ to the column, “InvoiceDate,” as shown above 

in Figure 6.5.  To cancel the filter, simply click on the    to the left of the filter.   

 

Note:  Multiple filters may be applied to more than one column at a time.   

 
More complex or versatile filters may be created by selecting the “Custom” option from the drop-down list.  The 
“Custom” option allows the user to create conditions bound by an “And/Or” clause.  When “Custom” is selected, 
the “Custom AutoFilter” window appears as highlighted in Figure 6.6 on the following page.  For example, the 
user selects “is greater than or equal to” and enters a value of 500 to locate documents that contain invoice 
amounts equal to or greater than $500, yet there are several criteria that can be utilized as you view the entire 
drop-down menu (i.e. “equals,” “does not equal,” “is greater than,” “is greater than or equal to,” “is less than,” 
“is less than or equal to,” “blanks,” “non blanks,” “like” and “not like”).  Click “OK” to apply the filter. 
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                                   Figure 6.6:  Custom AutoFilter 

 

Save Layout 
Once the grid has been customized to your liking (i.e. column sort order, column removal, column order), you 
have the option to save the grid layout.  To save the grid layout, press Ctrl+L or go to the “View” menu as 
demonstrated in Figure 6.7 and select, Grid Layout > Save Layout; the options to Restore and Forget Saved 
Layout are not available if there is no saved layout.  Once a layout has been saved, you may select Forget Saved 
Layout to delete it and restore the default look.   
 

 
                                                                                                                                 Figure 6.7:  Grid Layout 

 
If you have a saved layout and make changes to the grid during your session, you may select Restore Layout to 
revert back to the saved grid layout. 
                     

Note:  The “Indexing Queue” grid layout is saved automatically every time the user exits the queue. 
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Updating Documents 

After documents have been indexed, users may update or edit attribute data as well as revise individual 
documents.  As these changes are made, they are recorded in Document History which serves as an audit trail 
for administrative review.  Reasons for these changes to individual records may be noted in the Notes panel for 
future reference.  

Notes 
The Notes panel is beneficial to users because it allows for adding comments to a document as illustrated in 
Figure 7.1 below.  For example, the outlined document in this figure has a note.  When a note is entered for a 

specific document, the  icon appears in the Note column next to that document.  The Notes and History tabs 
are located at the bottom of the screen; click the Notes tab to view the comments for the highlighted 
document.  This note, ‘Additional services rendered—outstanding balance updated’ has been entered on 
7/18/2008 at 2:26:39 PM by the User “dogden”.  The Notes panel will update automatically as other documents 
are selected.  If the Notes panel has been removed from the view, it may be returned by selecting Notes from 
the View menu. 

 

 
                                                Figure 7.1:  Notes Panel 

 

Note:  Once a note is entered, it cannot be updated or changed. 
Note:  Notes cannot be searched. 
Note:  The “Update Document” permission is required for individual users to add notes.  
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Editing Document Attributes 
To edit a document, right-click on the highlighted document and select Edit (Ctrl+Shift+E) from the drop-down 
menu as demonstrated in Figure 7.2. You may also use the toolbar icon or the Document menu. 

                                                        

 
                                    Figure 7.2:  Edit Menu 

 

 

 

 

 

 

 
The “Edit Document” window appears so that changes may be made to the document as illustrated in Figure 
7.3.  The Document Type for editing in this sample is “Receipts”.  Once the document is updated, click “Save” to 
save the changes; if the user decides that no changes are necessary, click “Cancel”. 
 

 
                  Figure 7.3:  Edit Document 
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Selecting a new Document Type in the drop-down menu will refresh the screen to display the attributes 
applicable to the selected Document Type.  The window in Figure 7.4 appears to confirm the Document Type 
change.  Click “Yes” to proceed.  
 

 
                                                           Figure 7.4:  Confirm Document Type Change 

 
If the new Document Type has attributes that match the original Document Type, the initial data will be 
retained.  Any attributes of the new Document Type that do not match the original Document Type will be 
empty, and the new information can be entered.   
 
After changes have been saved, the user will be prompted to “Enter a Note” explaining the reason for the 
changes.  Enter any applicable notes as noted in Figure 7.5 and click “OK,” or click “Cancel” to save changes 
without adding a note.  
 

 
  Figure 7.5:  Enter a Note 

 
        

 

Note:  The “Update Document” permission is required for individual users to update documents.  
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Editing Multiple Documents 
To edit multiple documents, right-click on the highlighted documents and select Edit (Ctrl+Shift+E) from the 
drop-down.  You may also use the toolbar icon or the Document menu. 
 

When more than one document is selected for editing, only the attributes that are applicable to both 
documents will appear.  Check the box next to the attribute you wish to edit, update the index information and 
then click “Update” when finished.  This will update all the records with the new information.  See the sample in 
Figure 7.6. 

 

 
                                                                                Figure 7.6:  Multiple Document Edit 

 

Note:  The Document Type field cannot be changed when using “Multiple Document Edit” and must be edited 
individually. 

 

Grid Edit 

The grid displaying the indexed documents may also be edited directly using   (Ctrl+E) as illustrated in 
Figure 7.7 on the following page.  Toggling the Grid Edit button makes the search grid act much like a 
spreadsheet program such as Microsoft Excel in that you can type directly into the fields.  Use caution while 
Grid Edit is enabled as changes are saved automatically once you click off of the document row.  Fields 
highlighted in gray are either system fields or attributes that are not associated with the document type; these 
fields cannot be edited. 
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                                                                                     Figure 7.7:  Grid Edit 

 

Deleting Documents 
To delete a document, right-click on a record and select Delete, or highlight one or more records and select 
Delete from the “Document” menu as demonstrated in Figure 7.8. 
 

 

 

 
                                                                   Figure 7.8:  Delete a Record 

 
The “Confirm Delete” window appears to ensure that the user desires to delete the selected document as 
shown in Figure 7.9; click “Yes” to proceed. 
 

 
                                                                                                                                             Figure 7.9:  Confirm Delete 
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The user will then be prompted to enter a note explaining why the document was deleted as noted in Figure 
7.10.  For example, this document was deleted because it was a duplicate document in the grid.  Click “OK” upon 
completion of the note. 
 

 
                                                 Figure 7.10:  Enter a Note 

 
Records deleted from IQdesktop are never actually deleted but are flagged as such, much like the Windows 

recycling bin.  Toggling the    button allows a user to see or hide the deleted documents if he or she 

has permissions to do so.  Deleted records have a red  at the beginning of the record as shown in Figure 7.11.   
 

 
                                                                                              Figure 7.11:  Deleted Record 

 

Note:  Users must have permissions to delete documents and view deleted documents.  See the 
IQAdministrator’s Guide for more information. 

 



  IQmfp User’s Guide 10.0 

48 
 

Revising Documents 
IQdesktop supports the revision of documents so that original files can be replaced with more current files.   
Original files may still be accessed via the History panel (see the following page).   

 
In a “Search” tab, right-click on the highlighted document and select Add Revision, or select it from the 
“Document” menu as illustrated in Figure 7.15. 
 

Note:  See the Microsoft Office Connector, pg. 64, for information on revising Office type documents (.doc, 
.docx, .xls, .xlsx and .wpd). 

 

 

 
 
                                                                   Figure 7.15:  Add Revision 

 
After clicking Add Revision, the user will be prompted to locate a file to update the current record.  The new file 
will replace the existing file.  There is no limit on how many revisions are permitted to a document. 
 
To view previous document revisions, right-click on any of the “Revision” actions in the History panel and click 
View Revision as shown in Figure 7.16 on the following page.  To see the revision numbers, click the “Show 
Preview” button. 
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                                                                      Figure 7.16:  View Revision 

 
 

Note:  The file type being revised must be the same as the file type intended to be added, except in the case 
of .pdf files which may be .pdf or .tif. 
Note:  Documents that are revised will be re-queued for IQocr.  Only the most recent revision will be full-text 
searchable. 
Note:  The “Update Document” permission is required for revising documents. 

 

Document History 
Anything that happens to a document, be it user related or system related, gets recorded into the History panel 
making it easy for someone to see exactly who did what and when.  By default, the History panel is located at 
the bottom of the screen underneath the grid.  Highlight a document and click on the History tab at the bottom 
of the screen to see the History panel.  If the History panel was previously closed, selecting History from the 
“Document” menu will bring it back as shown in Figure 7.12. 
 

 
                                                         Figure 7.12:  Document History 
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The History panel shows three columns, “Action,” “Event Date” and “User Name” as seen in Figure 7.13.  These 
columns can be sorted just like the main search grid.   
 

 
                                                             Figure 7.13:  History of a Document 
                                                      

 
See Figure 7.14 of the following page highlighting the History Toolbar features—“Print,” “View Revision” and 
“Show Preview”.  The user may print the history of any document, view its revision (if any) or expand the action 
details to see more information. 

 

 
                                                            Figure 7.14:  History Toolbar 
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Additional Features in IQdesktop 
IQdesktop allows users to manage the electronic filing system interface with the additional menu features in the 
“Toolbar;” from left to right, the icons to these features represent the following functions:  Search, New Search 
Tab, Watch List, Routing List and Refresh.   

See Table 2 below to learn the feature and function of each additional feature. 

Additional Features Feature Function 
  

        
      Search 
      (Ctrl+F) 
 

Allows a user to search for documents 

 

 
 

Allows a user to open a new tab to perform additional searches without 
clearing the contents of the current tab 

 

   

       
           Watch List  
              (Ctrl+W)      
 

Allows a user to track specific documents as they are routed and updated 
by other IQ users, similar to a favorites list or bookmarks. 

 

       
            Route List 
               (Ctrl+R)          
                             

Allows a user to view documents that have been routed for review.  

 

            
                    (F5) 
 

Allows the user to update the current tab with any new documents or 
search results.   

 
                (CTRL+H) 

Activates the History panel 

 
                (CTRL+N) 

Activates the Notes  panel 

                                                               Table 2:  Additional Features and their Functions 



  IQmfp User’s Guide 10.0 

52 
 

New Search Tab 
The New Search Tab is beneficial to the user if they are managing two or more searches concurrently.  A user 
may open a New Search Tab by clicking the “New Search Tab” button in the toolbar as highlighted in Figure 8.1.   
 

 
                                                                                                                   Figure 8.1:  New Search Tab Icon 

 
Once the New Search Tab is selected, a “Search” window appears to initiate a new search via “Custom Search” 
or “Saved Queries” as illustrated in Figure 8.2; in this figure, for example, the new search is initiated via the 
“Custom Search’ for a Sales Report with the client name, ABC Company.  Click “Search”. 
 

 
           Figure 8.2:  New Search Tab—Custom Search 
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The new search results are displayed in a new search tab as illustrated in Figure 8.3.  The user may switch 
between the tabs to view the different search results.  Currently, an unlimited number of search tabs may be 
open.  To close a search tab, click the  button to the far right as highlighted below. 

 

 
                                                              Figure 8.3:  New Search Tab 

 

Route List 
The Route List shows a list of documents that were sent from other IQ users that may require some kind of 
attention.  A user can route a document to a single user or to multiple users via a Role.  If a document is routed 
to a Role, all members in that role will see the document in their Route List.    
 
To Route one or more records, highlight the record(s) and select Route from the right-click menu or from the 
“Document” menu as demonstrated in Figure 8.4. 

 

 
                                                          Figure 8.4:  Document Menu—Route  
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The “Document Routing” window prompts the user to select the User or Role to route the document to as 
displayed in Figure 8.5 below.  Check the “Add documents to my Watch List” checkbox if you wish to add the 
documents to your Watch List as well.  Click “OK”.  See the next section for more information on managing the 
Watch List. 

 

 
                                                                    Figure 8.5:  Document Routing 

 
See Figure 8.6.  Once a document is routed to a User or Role, the system attribute, “RoutedTo,” will be 
populated, indicating which User or Role the document was routed to.   

 

 
                                                   Figure 8.6:  Document RoutedTo Field 

 
To view the Route List, click the link in the “Tasks” pane or select the “Routing List” link from the “Tools” menu 
as demonstrated in Figure 8.7 on the following page. 
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                                                                                                  Figure 8.7:  Routing List 

 
The Route List shows up as its own tab and lists all documents that have been routed to the user logged into 
IQdesktop as seen below in Figure 8.8. 
 

 
                                                                    Figure 8.8:  Route List 

 
To remove routing from a document, highlight the record and select Clear Route from the “Document” menu or 
the right-click menu.  As soon as the user clicks Clear Route, the “RoutedTo” attribute will empty.  If the route is 
cleared from the “Route List”, the document will disappear once the tab is refreshed. 
 

Note:  Documents may also be routed from the “Indexing Queue” while indexing documents.   
Note:  The “Update Document” permission is required for routing documents. 
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Watch List 
The purpose of the Watch List is to bookmark a document for future reference instead of having to search for it 
again.  To watch a document, highlight it and select “Watch Document” from the right-click menu or from the 
“Document” menu.   
 
The “Watch List” may be accessed from the “Tasks” pane or from the “Tools” menu as demonstrated in Figure 
8.9.  
 

 
       Figure 8.9:  Watch List 

 
The Watch List opens in its own tab as shown below in Figure 8.9 and is specific to each user. 

 

 

 

 

 

 

 

 

 

 
                                                                               Figure 8.9:  Watch List 

 
To stop watching a document, select Stop Watching (Ctrl+U) from the “Document” menu or from the right-click 
menu. 
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Export to Folder 
The Export to Folder feature allows documents selected in IQdesktop to be exported to a folder on the user’s 
PC; an HTML page with searchable metadata is also created.  The user can then manually burn these files to CD, 
etc.  This creates portability for the set of documents selected for reference outside of IQdesktop. 
 
Only the documents selected in the current grid will be flagged for export.  Hold down the CTRL key while 
clicking individual documents to select individual documents or press CTRL+A to highlight all of the documents in 
the grid.  Once all the documents have been selected, go to the “Document” menu and select “Export to Folder” 
to export the selected documents to a folder as demonstrated in Figure 8.10. 
 

 

 

 

 

 
               Figure 8.10:  Export to Folder 

 
The “Browse For Folder” window appears allowing the user to either select an existing location, or to create a 
new folder.   In Figure 8.11, the user had decided to send the documents to the “C:\My Exported Files” folder.  
Click “OK”. 

 
                                                                                   Figure 8.11:  Browse For Folder 
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The selected documents have now been exported to the “C: \My Exported Files” folder as noted in Figure 8.12.  
Click “Yes” to view the exported information. 

 

 
                Figure 8.12:  Export to Folder Completed 

 
 
Figure 8.13 below displays the exported documents in a searchable html file (default.hta).  Click the “View” 
hyperlink to view the documents in their native viewer. 
 

 
                                      Figure 8.13:  Exported Documents 

 
 
   

Note:  Searches performed from the default.hta file are case sensitive. 

 
 
 
 

 

 



  IQmfp User’s Guide 10.0 

59 
 

Duplicate 
To create a duplicate copy of a record, highlight the record and select Duplicate (Ctrl+D) from the right-click 
menu or from the “Document” menu as illustrated in Figure 8.14. 
 

 

 

 
                                                                   Figure 8.14:  Duplicate 

 
The Duplicate Document window will open as shown in Figure 8.15.  The duplicate record Document Type and 
attributes may be edited before clicking “Save”.   

 

 
                                                                                                                                                   Figure 8.15:  Duplicate Document 

 
The user will then be prompted to enter a note explaining why the document is being duplicated.  The user may 
either enter a note or click the “Cancel” button to save the new document without adding any comments. 
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Note:  Users must have the “Add Document” permission to create duplicate records. 

Show Associated 
When documents are scanned into the Indexing Queue, they arrive with a document type of “MFP Scan”.  After 
a document batch has been indexed, it may be useful to see the original scanned batch.  To show the original 
MFP Scan document batch, select Show Associated (Ctrl+O) from the “Document” menu as displayed in Figure 
8.16. 

 
   
                                                                         
                                                                Figure 8.16:  Show Associated 

All associated documents, if any, will appear in their own tab.  Associated documents display the   icon next to 
them as shown in Figure 8.17.   

 
                                                                                   Figure 8.17:  Associated Documents 

Note:  Users must have Allow access to the “MFP Scan” document type in order for them to appear as 
associated documents.   
Note:  Duplicate records are also linked together by using “Show Associated”. 
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Managing Document Types 

Document Types and Attributes may be added and edited from IQdesktop if the user has Allow permissions to 
“Manage Document Types.”  This feature is convenient for users and also allows administrators to give certain 
users access while still restricting them from other administrative functions that require the use of 
IQadministrator.  To Manage Document Types from IQdesktop, select it from the “Tools” menu as shown below 
in Figure 9.1. 
 

 
           Figure 9.1:  Tools—Manage Document Types 

 
Figure 9.2 below highlights the Manage Document Types tab which is the same screen that appears in 
IQadministrator.  For more information on Manage Document Types, see the IQmfp Administrator’s Guide 10.0. 
 

 
                                                                                                                 Figure 9.2:  Manage Document Types 
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Additional IQclient Applications 

In addition to IQdesktop, there are four other client applications that may be used to get documents and files 
into IQ: 
 

 Microsoft Windows Explorer Connector 

 Microsoft Office Connector 

 Corel WordPerfect Connector 

 IQscan 
 
Installation instructions for each connector can be found in the IQmfp Software Installation Guide 10.0.   

Microsoft Windows Explorer Connector 
Many users have electronic files that need to be stored in IQmfp.  For this purpose, IQmfp can use Windows 
functionality to initiate processing electronic files.  To do this, locate and highlight the file or files intended for 
filing in IQmfp. Right-click on the highlighted files and select Send To > IQdesktop as illustrated in Figure 10.1 
below.   
 

 
                                             Figure 10.1:  Send To IQdesktop 

 
 
The “Send to ImageQuest” window appears allowing the user to select a Document Type from the drop-down 
menu and assign attributes as shown in Figure 10.2 on the following page.  Click “OK” to submit the file to IQ.  
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               Figure 10.2:  Send To ImageQuest 

 

 
The “ImageQuest Connector for Windows Explorer” window in Figure 10.3 prompts the user that the selected 
number of files has been successfully saved to ImageQuest.  Click “OK”.    
 
 

 
                                                                               Figure 10.3:  Confirmation Message 

 
   

Note:  Users must have the “Add Document” permission in order to use the Microsoft Window Explorer 
Connector. 

 
 
 
 
 

 



  IQmfp User’s Guide 10.0 

64 
 

Microsoft Office Connector 
IQmfp provides an add-in for several Microsoft Office programs which allows for sending and in some cases 
opening documents from IQmfp.  The following Microsoft applications are supported: 
 

 Microsoft Word 2003 & 2007 

 Microsoft Excel 2003 & 2007 

 Microsoft Outlook 2003 & 2007 
 
Other Microsoft file types can to be sent to IQ using the Windows Explorer Connector; see the previous section 
for more information. 
 
The Microsoft Office Connector for Microsoft Word and Microsoft Excel installs a new toolbar with two new 
icons, one for saving files to IQ and one for opening files from IQ. 
 
For example, create a Microsoft Word document that you wish to save in IQ as displayed in Figure 10.4.  See the 
highlighted Save to ImageQuest icon in the new toolbar; click the icon to save the file to IQ. 
 

 
                                                                    Figure 10.4:  ImageQuest Icons in Microsoft Word 2003 

 
The “Save Changes” window appears allowing the user to “Add a Revision” or “Create a New Document” as 
demonstrated in Figure 10.5 on the following page.  Since this is a new document, adding a revision to an 
existing document is not possible so the option is disabled.  Select the Document Type and assign attributes; 
click “OK” when finished.  The file is now saved to IQ and is searchable from IQdesktop using the index 
information. 
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                                               Figure 10.5:  Save Changes 

 
Now that the document is stored in IQ, it may retrieved using IQdesktop or by using the Open from ImageQuest 
button from the ImageQuest Toolbar as seen below in Figure 10.6.  Clicking the Open from ImageQuest button 
brings up a new window allowing you to search for documents as well as access your Watch and Route lists. 
 

 
                                                                                                       Figure 10.6:  Open from ImageQuest 
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To find the document we saved earlier, click on the “Search” icon and enter the appropriate attributes and click 
the “Search” button.  See Figure 10.7 below.   
 

 
                                    Figure 10.7:  Open from ImageQuest Search Screen 

 
The search results will be displayed in the grid.  Double-click on the record or highlight the record and click the 
“Open” button as shown below in Figure 10.8 to open the document. 
 

 
                                                                                                                     Figure 10.8:  Search results 
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If we now make additional changes to this document and click the Save to ImageQuest button, the “Add a 
Revision” is now enabled.  The index information will be automatically populated and may be changed if 
necessary.  Click “OK” to send this revised document to IQ. 
 

 
                                                Figure 10.9:  Add a Revision 

 
When a document is revised, the Document Type and all associated attributes on the “Save Changes” screen will 
replace the existing document metadata.  Any previous versions of the document can still be accessed from the 
History panel by highlighting the “Revision” action and clicking on the “View Revision” button as shown on the 
next page in Figure 10.10. 
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                                                                                                            Figure 10.10:  View Revision 

 

Note:  Microsoft Word and Excel 2007 function the same as the 2003 versions; however, the icons are located 
in the ImageQuest ribbon as seen in Figure 10.11. 
Note:  Only the most recent document revision can be opened directly from Microsoft Word or Excel. 

 
 

 
                                                                Figure 10.11:  ImageQuest Ribbon in Microsoft Word 2007 
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The Microsoft Office Connector for Microsoft Outlook differs from the Microsoft Word and Excel Connectors in 
that it allows the user to save emails and/or attachments into IQ and there is no option to open from IQ.  The 
Microsoft Office Connector for Microsoft Outlook installs a new toolbar with one button called “Send to 
ImageQuest”.  This button has two options, “Entire Email…” and “Attachments Only…”. 
 
To store an email message in IQ, open Microsoft Office Outlook and locate the Send to ImageQuest icon in the 
toolbar as highlighted in Figure 10.11.   
 

 
                                        Figure 10.11:  Microsoft Outlook 2003 — Send to ImageQuest 

 
To send the entire email to IQ, highlight the email in Microsoft Outlook, click Send to ImageQuest and select 
“Entire Email…”.  The Send to ImageQuest window appears allowing the user to select a Document Type and fill 
in the associated attributes as demonstrated in Figure 10.12 below.  Click the “OK” button when finished. 
 

 
                                                                                                                                              Figure 10.12:  Send to ImageQuest 

 
A message box will appear saying that the file was saved successfully to IQ.  The email message is now 
searchable from IQdesktop. 
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To send one or more attachments without the main message body, follow the same steps, but this time select 
“Attachments Only…” from the Send to ImageQuest toolbar.  
 
The “Choose Attachments” window appears allowing the user to select which attachments get stored in IQ as 
modeled in Figure 10.13; click “OK”.   

 

 
        Figure 10.13: Choose Attachments 

 
The Send to ImageQuest window appears allowing the user to select a document type and fill in the associated 
attributes as seen in Figure 10.14.  Click the “OK” button when finished.  A message box will appear saying that 
the files were saved successfully to IQ.  These attachments are now searchable from IQdesktop. 
 

 
                                                                                                                                                  Figure 10.14:  Indexing Attachments 
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Note:  In the example on the previous page, three file attachments were selected to send to IQ.  All three 
attachments will receive the same index information. 
Note:  Users must have the “Add Document” and “Update Document” permissions in order to use the 
Microsoft Window Office Connector. 

 

Corel WordPerfect Connector 
IQmfp provides an add-in for Corel WordPerfect X3.  It functions identically to the Microsoft Office Connector 
for Microsoft Word 2003 and has the same toolbar icons (see Figure 10.15).  Follow the instructions starting on 
pg. 64 for more information. 
 

 
                                                                Figure 10.15:  IQ Icons in WordPerfect X3  

 

Note:  Users must have the “Add Document” and “Update Document” permissions in order to use the Corel 
WordPerfect Connector. 

 

IQscan 
IQscan allows users to scan and index documents into IQ and at the same time optionally make a copy and/or 
send a fax simultaneously with the touch of one button.  HP Smart Document Scan Software (SDSS) is required in 
order to use IQscan. 
 
To access IQscan, go to Start > All Programs > Informa Software and click on IQscan.  The “Configure Options” 
window will appear on the first launch as seen in Figure 10.16 on the following page.  Select the scanner you 
wish to use from the drop down list.  This scanner must already be configured to work with SDSS.  Please refer 
to the HP SDSS documentation for further information on setting up your scanner. 
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                 Figure 10.16:  Configure IQscan Options 

 
After selecting the scanner, clicking on the “Advanced…” button will display the IQscan Profile Settings window.  
The IQscan profile is automatically created in SDSS by clicking this button.  Of the four tabs in this window, only 
two of them are editable:  “Scan” and “Process”.  The “Profile” and “Destination” tabs are not editable in this 
particular profile and will revert back to the default settings if they are modified. 
 
The “Scan” tab allows the user to set the paper source, page size, color mode and other settings related to 
scanning while the “Process” tab allows the user to set other scanner options such as automatic page resizing 
and automatic page cropping.  See Figure 10.17 on the following page. 
 
 



  IQmfp User’s Guide 10.0 

73 
 

 
                                                                                                                       Figure 10.17:  IQscan Profile Tabs 

 
The “Printer Settings” section of the “Configure Options” window allows the user to select which printers will 
output the “Copy” or the “Fax”.  The printers must be setup on the local workstation first. You must also have 
third party fax software installed that utilizes a virtual fax printer in order to use the “Fax” capability of IQscan 
such as Captaris RightFax or Microsoft Fax.  After configuring the “Scanner” and “Printer Settings”, click the 
“Save” button as illustrated in Figure 10.18 on the following page.  This screen can also be accessed from the 
File > Options menu in the IQscan window. 
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                Figure 10.18:  Configure IQscan Options 

 
The main IQscan window now appears, allowing the user to Scan, Copy, and/or Fax a document as seen in 
Figure 10.19.  Scan and Copy are selected by default. 
 

 
                                                                                                                                     Figure 10.19:  IQscan 
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To only scan a document into IQ, click the “Copy” button to deselect it, click the drop down box to select a 
Document Type, fill in the associated attributes and then click “Scan” as seen in Figure 10.20. 
 

 
                              Figure 10.20:  IQscan – Scan to IQ 

 
The SDSS “Scan Progress” window is launched as seen in Figure 10.21 on the following page, allowing the user to 
manipulate the scanned images as they are scanned.  Please reference the SDSS documentation for further 
information on the “Scan Process” window. 
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                                                                                                               Figure 10.21:  Scan Progress 

 
After the last page is finished scanning, pressing the “Done Scanning” button will store the document in IQ and 
return the user back to the main IQscan window. 
 
If for example we had instead deselected the “Scan” option and enabled the “Copy” and “Fax” options, the user 
would not need to specify any index information.  After clicking the “Scan” button, the SDSS “Scan Progress” 
would still appear as shown above in Figure 10.21.  After clicking the “Done Scanning” button, the user is first 
prompted with the “Printer Options” as shown below in Figure 10.22. 
 

 
                               Figure 10.22:  Printer Options 
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Click “OK” to print the scanned document to the selected printer.  Since we had the “Fax” option selected during 
scanning, we are now prompted to enter the fax information for where the document should be faxed to as 
seen below in Figure 10.23.  In our example, we have our fax printer configured to use Captaris RightFax. 
 

 
                                                                         Figure 10.23:  Fax Information Dialog Box 

 
After filling in the fax information, click on the “Send” button to fax the scanned document to the recipient that 
was specified.   
 

Note:  Figure 10.23 above shows a screenshot from the Captaris RightFax client.  This screen will look different 
depending on the fax software configured in your environment. 
Note:  Users must have the “Add Document” permission in order to use IQscan. 
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